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Trademarks 
Unigraf, DPR and DTC are trademarks of Unigraf Oy. 

DisplayPort™ is a trademark of VESA. 

HDCP is a trademark of Digital Content Protection LLC. 

Windows® 8, Windows® 7 and Windows® XP are trademarks of  

Microsoft Inc. 

All other trademarks are properties of their respective owners. 

Limited Warranty 
Unigraf warrants its hardware products to be free from defects in workmanship and materials, 

under normal use and service, for twelve (12) months from the date of purchase from Unigraf 

or its authorized dealer. 

If the product proves defective within the warranty period, Unigraf will provide repair or 

replacement of the product. Unigraf shall have the whole discretion whether to repair or 

replace, and replacement product may be new or reconditioned. Replacement product shall be 

of equivalent or better specifications, relative to the defective product, but need not to be 

identical. Any product or part repaired by Unigraf pursuant to this warranty shall have a 

warranty period of not less than 90 days, from the date of such repair, irrespective of any 

earlier expiration of original warranty period. When Unigraf provides replacement, then the 

defective product becomes the property of Unigraf. 

Warranty service may be obtained by contacting Unigraf within the warranty period. Unigraf 

will provide instructions for returning the defective product. 

CE Mark 
DPR-120 meets the essential health and safety requirements, is in conformity with and the CE 

marking has been applied according to the relevant EU Directives using the relevant section of 

the corresponding standards and other normative documents. 
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1. ABOUT THIS MANUAL 

Purpose 
This guide is the User Manual of DPR-120 Reference Sink and DTC, Debug and Test 

Controller GUI for use in a PC with Windows® 8, Windows® 7 or Windows® XP 

operating system. 

The purpose of this guide is to 

 Give an overview of the product and its features. 

 Give instruction for the user on how to install the software and the drivers. 

 Introduce the HW features of the DPR-120 unit. 

 Give instructions for the user how use the DTC GUI. 

Product Version 
This manual explains features found in Debug and Test Controller GUI, DPR-120 DTC 

version 1.11. Please consult Unigraf for differences between versions.  

Please consult the Release Notes document in the installation folder for details of the SW 

and FW versions and changes to previous releases. 

Notes 
On certain sections of the manual, when important information or notification is given, text 

is formatted as follows. Please read these notes carefully. 

Note This text is an important note 
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2. INTRODUCTION 

Product Description 
DPR-120 is a High Bit Rate 2 (HBR2) and Multi Streaming (MST) capable Reference Sink 

and branch device. Debug and Test Controller GUI (DTC) is a graphical user interface for 

DPR-120. Test Automation Shell and its API are an optional interface for automated 

testing. 

 DP 1.2 compliant Reference Sink and Branch device 

 Is able to recognize and monitor up to 4 DisplayPort Streams 

 Local Sink functionality with DP 1.1 compliant monitor output 

 Debug and Test Controller GUI with stream status monitoring and EDID and DPCD 

read write and edit functionalities.  

Functionality in a Nutshell 
DPR-120 is a MST and HBR2 compatible DisplayPort Reference Sink and a configurable 

Display Port Sink and Branch Device. The GUI allows the user to configure the features of 

the Sink in order to test his Source or Sink DUT in different configuration scenarios. 

Note Please note that Monitor Out port is DP 1.1a compliant. E.g. its maximum video 

mode is 2560x1600p60 (RB). 

 

Note In the current release Monitor Out link is not HDCP compliant. If the monitored 

stream is HDCP encrypted, it will not be displayed on Monitor Out port. 
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SST and MST Modes 
DPR-120 can operate either in Single stream (SST) mode or Multi stream (MST) mode. 

The selection is done with the MST Capable check box in Main Link tab in DP Input 

Group. Please find the description in Chapter 4 below. 

In Single stream mode DPR-120 is seen as a single Local Sink. The local EDID and DPCD 

registers define its capabilities for the upstream source. The received stream for the Local 

sink is copied to DP Out port and also in the Monitored Stream. 

In Multi stream mode, i.e. when MST Capable check box is selected in the GUI, DPR-120 

is seen as a Multi-stream capable DP Sink. The received streams are forwarded according 

to the intent of the Upstream Source. In normal case one of the streams is for the DPR-120 

Local Sink but this is not necessary the case. All four possible streams can be forwarded to 

downstream sinks as well. 

Based on the Stream Selection on the Main Link tab in DP Input Group one of the input 

streams is selected for monitoring. The details of the stream is shown in the status fields of 

the Debug and Test Controller GUI and the stream is also forwarded to the Monitor Out 

port. 
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Monitor Out Port 
Monitor Out is a DP 1.1a compliant display output for monitoring the stream selected on 

the Main Link tab in DP Input Group. Monitor Out port does not support HDCP. 

A copy of the monitored stream is fed to Monitor Out unscaled, as received. DPR-120 

assumes that the monitor connected to the Monitor Out is able to support the stream. 

Note: Please note that Monitor Out port is limited to DP 1.1 capability (2560 x 1600 p60 

(RB) resolution) only. 

 

Note: Please note that Monitor Out port is not detecting the display capabilities of the 

connected monitor. The stream selected on the Main Link tab in DP Input Group is 

output unchanged. 

 

Note Please note that Monitor Out does not support HDCP. An HDCP encrypted input 

video stream will not be output to this port. 
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DPR-120 Hardware Features 
The image below describes the connections and controls of DPR-120 and their description 

 

Name Description 

DP In DisplayPort input from the upstream Source 

DP Out DisplayPort output to the downstream Sink 

Monitor Out Copy of the monitored DisplayPort stream. 

Headset Out Analog audio output. (Currently not in use) 

S/PDIF In Optical audio input. (Currently not in use) 

S/PDIF Out Optical audio output. Audio embedded in the monitored stream. 

Power In +5 Vdc Power Supply Input 

USB USB connection to the host PC 

Reset Pushbutton to reset the unit 

Status LEDs Status 1: HDCP Status 
Off = disabled 

On = enabled 

Status 2: Monitor Out 

Status 3: DP Out 

Status 4: DP In 

Off = Cable disconnected,  
Blinking = Cable connected but no link,  
On = Link training successful. 

TSYNC In Synchronizing input. TBD 

TSYNC Out Synchronizing output. TBD 
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3. INSTALLATION 

Unpacking 
The DPR-120 product shipment contains 

 The DPR-120 unit 

 AC/DC Power supply (100 to 240 Vac 50/60 Hz input, +5 Vdc output)  

 USB cable  

 The Utilities CD containing the SW installer. An electronic copy of this User Manual 

is included. 

Contents of the Installation CD 
The DPT-120 Installation CD contains DPR-120 Setup utility including the following 

items: 

 Windows drivers (installed during set up) 

 DPT-120 firmware matching the SW version included (embedded in the GUI 

application, automatically updated when GUI run) 

 DPR-120 Debug and Test Controller software GUI (installed during set up) 

 DPR-120 Test Automation Shell (optionally installed during set up) 

 User Manuals including this document. 

Note: Please install the software before connecting the DPR-120 in your PC. 

 

Note: System administrator's privileges are required for performing the installation. 

Software Installation 
 Start the installation by running DPR-120 Setup.exe 

Once the installer has started a welcome page is displayed. The welcome page shows the 

software package release version. 

 Click Next to continue. In the next dialogs you will able to define which software 

components are installed.  

 A fresh version of the DPR-120 DTC Application 

 Optionally the Device Drivers. 

The next two dialogs will allow you to define the install folder in your PC and the Start 

Menu folder used.  

 When you are ready with the selections, click Install to start the installation. 

 Click Finish to exit installation. 
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Firmware Update 
The DPR-120 firmware matching with the DP DTC GUI SW is embedded in the GUI 

application code itself. When DP DTC application is launched the firmware version 

programmed in the hardware is automatically checked and updated if needed. 

License Keys 
For some feature of the DPR-120 you will need a hardware specific license key. Each 

license is valid for one specific device only. By using the GUI you can read the Seed 

Number of your DPR-120 unit. For a given Seed Number, Unigraf will provide you a 

License Key that will enable you to use the GUI from any PC to control your DPR-120. 

You can usually find your License Key printed in a sticker that can be: glued on the unit’s 

enclosure, included in the delivery package or among its related documents. If you cannot 

locate the License Key, please contact Unigraf and provide the Seed Number shown on the 

dialog in order to receive your License Key. 

The Basic Debugging features of the DPR-120 do not require a license keys. When 

purchasing additional features like Compliance Test Tools and Test Automation Shell, you 

will be provided the license key matching the new features. The key will enable the 

corresponding features in the DP DTC GUI. 
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 Insert each of the 32 character long License Keys in the field provided and click  

Add License. When you have inserted all licenses, click Proceed. The license keys are 

now saved in your PC and you can constantly use the device from this PC. 

Note Please note that each license is bound to one specific DPR-120 unit. The same 

license can be used with any number of PCs. 

 

Note The License Key never includes characters I, G, B, O because of their similarity 

with the corresponding numbers. If in doubt, please use numbers. You can use copy 

and paste to insert the License Key. 

 

Note The DPR-120 unit must be connected to your PC for entering the License Key. 
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4. DEBUG AND TEST CONTROLLER GUI 

Debug and Test Controller GUI (DTC) is the user interface for DPR-120. The various 

functionalities are divided into groups and tabs providing the user in each tab functions 

related a certain task or operation. Some of the functions need a license and the related 

groups are visible in the GUI only when a valid license key has been entered. 

The following chapters describe the contents of the DTC and the related functions. 

DP Input monitors the status and the functions related to the DP Input interface from the 

upstream Source Device. The user can monitor the streams received by DPR-120. This 

group is always visible and is not enabled by a license. 

Terminal is a tool for running embedded DPR-120 commands. 

Source DUT Testing is the group for running CTS Tests 

DP Input Group 
This tab has six tabs, each dedicated to a certain function. 

Main Link Tab  
Main Link tab contains four panels: Link Status, Link Configuration, Stream Status and 

optionally Streams / Timeslot allocation (enabled with a license).  
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Link Status 

Link Status displays the status of the link training and the link parameters negotiated 

between the DPR-120 Sink and the Upstream Source. The data is retrieved from the DPCD 

registers of the DPR-120 Sink. The status is updated automatically.  

Link Configuration  

Link Configuration allows the user to change the way the Sink capabilities are announced 

in the DPCD registers of the DPR-120 Sink. Maximum Lane Count and the Maximum Link 

Rate are set with their appropriate radio buttons. For enabling the Multi Streaming (MST) 

support select the MST Capable check-box. 

To update the new status to the DPCD registers click Apply Changes.  

To apply a Hot Plug Detect pulse automatically after updating the status, select Generate 

HPD pulse on Apply. HPD pulse duration will be defined in the Bottom Panel. 

Stream / Timeslot Allocation 

Streams / Timeslot Allocation panel is enabled with MST Debug Extension license key. The 

panel shows the time slot allocation for the various MST stream payloads in the received 

upstream link. In case of SST operation, the panel is empty. 

In the example case above, time slots 1 to 31 have been allocated to VC Payload (VCP, 

Virtual Channel Payload) 1 and time slots 32 to VC Payload 2. Time slots 63 and 64 are 

unallocated. 

Port number for VC Payload 1 is 0x08 and for VC 2 0x00. The Payload Bandwith Number 

for both payloads is 0x04b1. 

Stream Status 

Video Signal Status information is retrieved from the DPR-120 Local Sink input 

measurement block. It indicates if valid video is received in the stream. 

Note: DPR-120 video signal status is based on the capabilities of the used STDP9320 

chip. The chip can only process timings up to 4K30Hz. This LED will not provide 

any meaningful information for pixel clock timings exceeding 4K30Hz. 

Video Timing Details are retrieved from the Main Stream Attributes (MSA) of the 

monitored stream.  

Note: Please note that the MSA information used for Video Timing Details is provided by 

the Upstream Source, it is not measured by the DPR-120 Local Sink. 

The 16-bit CRC values of the three color components calculated by the Sink hardware. To 

re-read, click Update. 
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Bottom Panel 
The bottom panel of the dialog is shown in all tabs of the DP Input group. It includes the 

controls for the Hot Plug Detect (HPD) signal. 

To apply a HPD Pulse with programmable duration click Pulse HPD. The duration will be 

defined in the provided field. 

For applying a short pulse click Short Pulse HPD. Pulse duration is 1 ms. 

Clicking the De-assert HPD button will cause HPD line be set to low (de-asserted) and 

hence no HPD pulse can be generated while HPD line set to low. Click the Assert HPD to 

re-activate (assert) the HPD line. 
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E-EDID Tab 
This tab provides tools for accessing the EDID of the DPR-120 Local Sink presented to the 

Upstream Source Device. There are three basic functions: 

 Load and save EDID data files in the host PC 

 Edit the EDID contents 

 Program and read the contents of the hardware EDID memory 

EDID Files 

With Load… and Save as… you can read and write a hex EDID file from your PC. Please 

note that the program does not alter the contents of the EDID file or verify its integrity 

during load and save operation. 

Note Currently the EDID Editor does not support Display ID. You can however modify 

hex EDID files with the HEX Editor or load and program externally generated hex 

EDID files that have Display ID content. 

HEX Editor 

When EDID content is either loaded from a file or read from the hardware EDID memory, 

it is shown in the EDID Data panel on the left hand side of the dialog. You can edit the 

EDID contents by typing over the existing values. The altered content is highlighted with 

RED. Please note that Hex Editor itself does not alter the contents of the EDID data or 

verify its integrity. 

Once you are done with editing the data, you can either save it to an *.ecd file in your PC 

with Save as… or program it to the hardware EDID memory with Write. 
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EDID Editor 

You can edit the EDID structures of the data in the HEX Editor by clicking EDID Editor. 

EDID Editor is launched in a separate pop-up window. 

The Main Window 

The EDID Editor main window is divided into three logical areas. The bottom part of the 

window contains the command buttons, and the log view. The top-left portion shows the 

currently edited E-EDID blocks in a tree-form, and the top-right portion shows an edit 

control for the currently selected item, possibly a list of sub-keys and their names (The list 

is not shown for all values) and the HEX-view of the block collection. 

Command Buttons 

Load: Load an EDID block collection file from disk. 

Save: Save the current block collection to a disk file. 

Show Hex: Show or Hide the HEX view. 

Show Log: Show or Hide the Log view. 

EDID Editor Features 

The EDID Editor currently supports VESA E-EDID block versions 1.3 and 1.4. As the 

standard defines, the versions 1.0, 1.1 and 1.2 are supposed to be backward compatible, and 

therefore the VESA E-EDID decoder will also show their contents. However, in these cases 

it should be noted that the error checking is not compliant with restrictions given in these 

older versions of the standard. In addition to VESA E-EDID block, the CEA-861 versions 

1, 2 and 3 EDID blocks are also fully supported as well as the VESA Block Map Extension 

blocks. 
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Practically unlimited number of extension blocks may exist in a single collection. The 

number of blocks is limited by VESA Specifications and possibly by available system 

resources. Most EDID blocks contain a structure that is very similar to a tree-structure. The 

EDID Editor decodes each block into a tree-view of the block. The tree-view then contains 

all values contained within the EDID block. The contents can then be easily browsed, using 

only a few mouse clicks. The EDID Editor has a support for automatic variables, such as 

the block checksum. When the user changes a value in an EDID block, the tool will update 

the checksum accordingly. The automatic variables appear as read only values for the user. 

A log print will be made when an automatic variable is updated by the editor.  

HEX View: An optional HEX data display of all blocks in the collection. The view also 

shows the latest changes highlighted. 

LOG View: An optional LOG view, which will contain log prints generated by the editor. 

Mostly it will list values that have been automatically updated due to edits. 

Editing tips 

Editing an EDID block is very straightforward, but there are some special cases where the 

user must know how to accomplish certain types of tasks. 

 Enter key will apply text-edit values and combo-box selection. 

 To apply new setting to binary values (ones that show a check-box), please click the 

Set button. 

 When you see a Quick Config button appear below an editor, you can access a 

configuration menu that allows you to quickly select one of multiple pre-defined 

setup options. 

 In CEA-861 blocks, you can add and remove 18-byte descriptors and CEA data 

blocks by setting the values “18-byte Descriptors in this block” and “CEA Data block 

count”. Unfortunately re-arranging the descriptors and CEA data blocks is not 

supported yet, so you need to be careful when editing these. 

 Enter hex values with prefix “0x” or “$”, no prefix means a decimal value. 

 You can always enter HEX or DEC, even if the value is presented as HEX, and/or 

value range is given in HEX. 

 Floating point values must be given with period “.” as decimal separator, even if your 

localization setting defines decimal separator as comma (or other). 

 Remember to click Set after changing a bit-value presented as a single check-box if 

you want the new value applied. 

Note It is recommended that you back up the un-edited EDID contents to a file before 

editing and writing it to the card. 

Saving EDID Data 

When you are done with editing you can either save the EDID contents to a file in the PC 

or bring it in the HEX Editor.  

For saving the data to a file in your PC click Save. 

For bringing the data to the HEX Editor close the EDID Editor window by clicking the 

Window Close button in the top right hand corner of the window. You will be asked if you 

would like to copy and replace the EDID data in the HEX Editor. Click Yes to replace the 

data, click No to discard the modifications.  

When you are back in the HEX Editor, the bytes that the EDID Editor changed are 

highlighted with BLUE BACKGROUND. 
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MSA Log Tab 
MSA Log collects video status information from the stream selected In the Main Stream 

tab. The data will be stored since the DTC GUI was launched or Clear was clicked. 

Click Columns… to select which data fields are shown. Please find a list of available fields 

and their column labels below: 

Label Description Default 

Timestamp Timestamp in milliseconds from the re-start of the HW  

VCP IP Virtual Channel Payload ID  

VSTAT Video status (On / Off)  

HPOL Horizontal Sync polarity (+/-)  

HTOT Horizontal Total in pixels  

HS Horizontal Start in pixels  

HACT Horizontal Active in pixels  

HSW Horizontal Sync width in pixels  

VPOL Vertical Sync polarity (+/-)  

VTOT Vertical Total in lines  

VS Vertical Start in lines  

VACT Vertical Active in lines  

VSW Vertical Sync width in lines  

CEF Color Encoding Format  

BPC Color Depth per Channel  
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You can save the log in Comma Separated Values (*.csv) format in your PC by clicking 

Save. 

Note When swapping between monitored streams, the first listing, indicating 

VSTAT=Off is caused by the monitoring circuitry. Please omit this listing. 

CRC Log Tab 
CRC Log collects CRC values of the three color components of the received frames from 

the stream selected In the Main Stream tab. The logging is enabled by selecting the Enable 

Logging checkbox. 

You can save the log in Comma Separated Values (*.csv) format in your PC by clicking 

Save. 
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DPCD Tab 
DPCD tab is a tool for monitoring and editing the DPCD registers of the DPR-120 Sink. 

The tool consists of two independent monitoring and editing windows for the DPCD data. 

The user can freely select the the DPCD address areas shown on each panel.  

The DPCD Decoder panel on the right hand side shows the interpretation of the DPCD 

byte selected on the monitoring windows. The selected byte is shown with a green outline.  

In the combo box above the DPCD Decoder window you can select how the DPCD data is 

interpreted, either as DP 1.1 EDID, or as DP 1.2 EDID with Detailed Capability Info 

selected or not (DETAILED_CAP_INFO_AVAIL = 1/0). 

 By clicking Refresh you can re-read the data from the DPCD registers to the window in 

question.  

 By clicking Write Changes you can write the portion of data shown in the window in 

question to the DPCD registers. 
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 By clicking Set Reference you can store currently shown data as a reference for 

comparison.  

When you refresh the data from the DPCD registers the changed bytes will be highlighted 

with gray background. 

The fields edited by the user will be highligted with red color. 

Saving and Loading DPCD Content 

You can save the DPCD data in the address areas that you selected for the two windows as 

a file in your PC. You can save the content in three alternative formats: 

 Binary DPCD Fata File format (*.DPD). This is Unigraf proprietary format. You can 

also load the DPCD content stored in this format. 

 Comma Separated Values (*.CSV) for loading the data to a spreadsheet. 

 HEX Dump (*.HEX) in a human readable text format. 

 By Clicking Save you will be able to select the location and the format of the file.  

 By Clicking Load you can load DPCD data saved in DPCD Data File (*.DPD) format to 

the editor.  

 In order to program the data into the DPCD registers of DPR-120 Local Sink click Write 

Changes. 

Note - Writing DPCD data to the DPCD registers of the DPR-120 Local Sink will 

potentially affect the status and capabilities of DPR-120 as seen by the upstream 

source. 

- User control like Link Training or mode changes will modify the content of the 

DPCD registers 

- During a reboot of DPR-120 the DPCD registers will be returned to their default 

values. 
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AUX Tab 
AUX Tab is an AUX Channel Monitor for recording the AUX Channel traffic in the 

upstream link. The operation of this built-in AUX Monitor of DPR-120 is in many ways 

similar to Unigraf’s DPA-400 AUX Channel Monitor. The advantage of the built-in 

function is that no extra connectors are used in the signal path that could potentially 

degrade the quality of the signal. 

When acquisition is enabled, the AUX Channel Monitor collects all AUX Channel 

transaction between the upstream source and DPR-120. Each message is shown in the log 

dialog as time stamped raw data and also in its parsed form. In order to help the user 

compare the logged data to the specification, the parsed data is expressed with the same 

terminology used in VESA DisplayPort™ documentation. 

Please refer to a full description of the AUX Channel Monitor features of in chapter AUX 

Monitor later in this document 

The AUX Monitor function is enabled with MST Debug Extension license key.  
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Terminal 
Terminal is a tool for running embedded DPR-120 commands. 

Currently there are three commands 

Command Description 

help List the available commands 

dpcd_rd <address> <count> Read DPCD register content. <address> is the start address; <count> is 
the number of register locations read. Both values are decimal by 
default, please use 0x prefix for hex. 

dpcd_wr <address> <value> Write <value> to DPCD register <address>. Both values are decimal by 
default, please use 0x prefix for hex. 

 

Click Clear to clear the Terminal Output panel. 
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Source DUT Testing 
Source DUT Testing section is the GUI to run the compliance tests with DPR-120. Please 

refer to a full description about the CTS Test GUI features in chapter Running 

Compliance Tests later in this document 
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5. AUX CHANNEL MONITOR 

The AUX Tab 
The tab has to dialogs. The Transaction list in the left displays the acquired AUX channel 

transactions and events. The Message details panel on the right side of the tab shows the 

parsed interpretation of the currently selected AUX channel transaction line. The Start 

acquisition / Stop acquisition button controls collection of the data. 

Decoding the Data 
The AUX Monitor is compatible with both DisplayPort™ versions 1.1b and 1.2. With 

DPCD Decoder mode in the lower right hand corner of the dialog you can select which 

version is used and how the messages will be decoded. 

The options are 

 DPCD 1.1 Decoder 

 DPCD 1.2 Decoder DETAILED_CAP_INFO_AVAILBLE bit set =1 

 DPCD 1.2 Decoder DETAILED_CAP_INFO_AVAILBLE bit set =0 
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Inspecting the Acquired Data 

Data Lines 
The data is organized in lines, each numbered starting from 1 and marked with a 

timestamp. There are five kinds of data: 

Information 

Identified by the text “INFO” in their Type column, they provide some useful information 

like the time acquisition has started and stopped or the logical state of the inputs, etc. 

Transactions 

Identified by the text “Native” or “I2C” in their Type column, they report an AUX channel 

data transfer, either a data Request or a data Reply. 

Events 

Identified by the text “Event” in their Type column, they signal the state change in one or 

more of the monitored inputs. 

Sideband Channel Messages 

The Isochronous Transport Service uses the sideband communications over sideband 

channel (AUX CH and HPD) for the management of topology/virtual channel 

connection/Main Link and performs Main Link symbol mapping. 

Error 

A line Type reading “Error” marks the detection of an illegal AUX channel data packet. An 

irregular start condition, an irregular stop condition or transfer of a number of bits which is 

not a multiple of 8 are all conditions that cause an error line. 

Columns 
The data on each line is ordered in columns. Each column provides additional information 

about the data, facilitating its viewing and interpretation: 

Line 

This column displays the line number, starting from 1, and cannot be hidden. 

Timestamp 

Each line is identified by its timestamp, marking the instant when an event or error was 

detected, or when a data transaction got started. The timestamp can be displayed as a time 

delay from the start of the acquisition (absolute) or from the previous line (relative). The 

timestamp can be displayed in milliseconds or in minutes, seconds and microseconds. 

From 

This column indicates the originator of the data line: 

 “Source” and “Sink” for an AUX channel transaction, respectively 

a data Request and a data Reply. 

 “Source Trace” and “Sink Trace” respectively for Sideband 

Message data Request and Reply. 

 “DPR-120” for error and information lines. 

 “Unknown” for signal state change events. 
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Type 

This column provides additional information about the type of the line: 

 “Native” marks Native AUX channel Requests and Replies. 

 “I2C” marks I2C AUX channel Requests and Replies. 

 “Sideband Request” and “Sideband Reply” to mark the Sideband 

Channel messages 

 “Event” is used for signal state change events. 

 “INFO” is used with information lines. 

 “Error” is used for illegal conditions detected on the AUX channel. 

Details 

This column contains a condensed description of the line content. 

Data 

The binary data exchanged during AUX channel transactions, in hexadecimal notation. 

Message Details 
The Message details panel is used to provide a detailed, parsed explanation of the line 

currently selected in the Transaction list. For AUX channel transaction data, for each of the 

DPCD memory locations affected, the panel lists: 

 All data bytes read or written. 

 All DPCD memory locations affected. 

 The name of the locations and of each of their bit fields. 

 All bit field’s numeric and binary values, together with their decoded value. 

 The Replies outcome (AUX_ACK, AUX_NACK, I2C_DEFER, etc.). 

Selecting Columns in the Transaction List 
You can customize the Transaction list by clicking the right button of your mouse over the 

list. From the pop-up menu, you can choose which columns to display in the list. 
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Selecting Font and Colors of the Transaction List 
Click the right button of your mouse over the transaction list, and in the pop-up menu, click 

Fonts & Colors … to open the Options dialog. In the dialog click Select new font. You 

can now select the font style, color and size used for displaying the Transaction list and the 

Message details. 

Coloring DPCD Address Ranges 
In order to improve the readability of the Transaction list, you can mark the AUX channel 

transactions where a certain DPCD register address or address range is accessed with a 

color of your choice. 

Click the right button of your mouse over the transaction list, and in the pop-up menu, click 

Fonts & Colors … to open the Options dialog. In the lower part of the dialog click Add … 

to open the New range dialog. 

In the New range dialog select the access type, start address and end address of the range 

that you want to be colored. Click Accept. 

Select the range you just created from the Colored addresses ranges list and click the Font 

Color and Background Color buttons to select the colors desired. 

You can create multiple simultaneous coloring rules to help you get a better at-a-glance 

view of the data captured. Please see an example on the next page. 
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Searching for Data in the Transaction List 
You can search and highlight lines in the Transaction list representing access to a selected 

DPCD location. Press Ctrl + F to open the search dialog and select the access type and the 

DPCD location address that you want to search. 

The first occurrence of the found access is selected and the rest are highlighted.  

You can use the same search criteria and search again by pressing F3. 
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Filtering Data in the Transaction List 
By right-clicking on the dialog and selecting Filters you can set up rules describing which 

data lines are shown in the Transaction List. You can choose the data based on: 

 The type of data line 

 The origin of the message 

 The DPCD address range 

In the Filters drop down menu you can find by default a set of pre-programmed 

filters. 

The Custom Filter dialog provides you a possibility to add and modify new filters. 

The pre-programmed filters are listed in the dialog. You can copy their structure as 

bases of your custom filters. It is advisable not to modify the pre-programmed filters 

directly but make copies of them. 

In the Stored custom filter definitions panel you will have the list of currently 

defined Filters. On the right hand side buttons you can define new Filters, rename or 

delete them. You can also reorder their appearance in the Filters pull-down menu. 

In the Filter Rules panel lower in the dialog you can review and change the Rules in 

the selected Filter. By clicking Add… you can create new rules, clicking Edit… 

you can review and edit existing Filters and by clicking Remove from the Filter 

definition. 
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When you click Add… or Edit… Edit Filter Rule dialog opens. In the dialog you 

can in detail define the action of the rule, select the event and the event details. 

You can get help by clicking Help. The “Help” text is attached to Appendix C of 

this document. 

Note Please note that Filters are a very powerful tool. They can however unintentionally 

hide valuable data from you. Please be careful when applying custom filters. 

A good practice is to start from an existing filter and gradually add new rules while 

testing their performance.  

 

Note  Filtering and selecting the columns for display do not affect the actual data 

acquisition. All transactions and their full data are always captured. 

 

Saving Recorded Data 
After the acquisition is stopped, the data displayed in the Transaction list can be saved as a 

binary file or as a report in a readable HTML or CSV format. In its binary form, the saved 

data can only be opened by the AUX Monitor feature of DPR-120 or by using Unigraf 

DPA-400 GUI. The HTML format can be opened with any available HTML browser, the 

CSV (Comma Separated Values) format can be opened with various text editing and 

spreadsheet tools. 

Saving to a Binary File 

From the top pull down menu select File -> AUX Log as … and specify the name for the 

file to be saved. You can reload a previously saved file for later inspection using File -> 

Open AUX Log …. 

Creating a Test Report 

The AUX Monitor includes a report generator that creates a test report of the results 

displayed in the Results Grid.  

The report generated by the GUI application includes all the lines from the Transaction list 

and the content of the Message details panel for each of them. You can also include 

detailed description of the monitored source and sink and the used TE in the report. 

For creating a report select from the pull down menu File -> Save AUX Report as …. You 

can choose either a HTML or CSV format. 
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After selecting the report file name, in the Report Information dialog you can add a 

description of the monitored source and sink devices, and your personal remarks that will 

be included in the report. 

Save the report by clicking Accept or return to the main window without saving by clicking 

Cancel. After the report is saved, your default internet browser will be opened to display 

the report file created. 

The information entered in the dialog fields will be available also for the following reports 

until the GUI is closed. 

Note  You can create reports from previously acquired data that has been saved in binary 

format. Use first File -> Open AUX Log … and then File > Save AUX Report as 

…. 

Note  Report creation for large amounts of acquired data can generate large HTML files 

and take several minutes. During this operation the GUI will not respond to user 

commands. Please, be patient. 
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6. RUNNING COMPLIANCE TESTS 

DP Link Layer CTS test capability is a separate add on to DPR-120 Debug and Test 

Controller GUI. The tests are included in the GUI, all you need to have is the license code 

to enable them. 

In order to get details of the content of each individual CTS Test Product please refer to 

document Guide to Unigraf DP CTS Tool Options. If you have any additional questions, 

please contact Unigraf or your local representative. 

DUT Capabilities 
Before running the tests you have to define the capabilities of the Source DUT for the test 

engine. This is done in Source DUT Testing > DUT Capabilities tab. 

The capabilities listed on the tab are explained in detail in chapter  

3 Compliance Test Operation  

of document  

VESA® DisplayPort® Link Layer Compliance Test Specification: Extension Set 1. 

Note Please make sure that the capability tables are completed before running the tests. 

The result of the test might be misleading if the DUT capabilities and the table do 

not match. 

You can save the settings stored in the DUT Capabilities tab by selecting File > Save CTS 

Settings …. You can retrieve saved settings by selecting File > Open CTS Settings …. 

http://www.unigraf.fi/content/download/1194/14271/Guide+to+Unigraf+DP+CTS+Tool+Options.pdf
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Running CTS Tests 
The Source DUT Testing > Run Tests tab lists the tests enabled with the CTS Test 

Product enabled in your Debug and Test Controller (DTC) GUI. The test name and the 

reference number refer to the applicable VESA® DisplayPort® Link Layer Compliance 

Test Specification. The GUI and the related FW on DPR-120 implement the test according 

to the specification in question. Please refer to the VESA Specification for detailed 

description of the procedure of the test. 

For running a test, select the test with your mouse and click Run. For selecting multiple 

tests hold down the Shift key of your keyboard while selecting the tests. 

Below the list of tests you can select how many times the selected tests are performed and 

the time between the tests. When repeating a sequence of tests, all selected tests are 

performed in each repetition. E.g. when you repeat tests 1, 2 and 3 two times, the sequence 

is: 1, 2, 3, 1, 2, 3. 

If the DUT needs time to recover after the completion of the test, you can include a pause 

after a test is completed and before the start of the next test. This is done in Idle time 

between tests field. The minimum time is 2 seconds. 

If you have programmed a series of test to be run, you might want to stop the execution if a 

failure or timeout occurs. Please check the Stop on fail and Timeout box. 

For clearing the Status Log and the Results matrix, click Clear Results. 
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Evaluating CTS Test Results 
The test procedure advancement is defined in the Status Log panel. It describes the steps of 

each individual test in the way defined in the corresponding VESA Compliance Test 

Specification. Please use the Status Log and the Specification side by side when 

interpreting the results. 

At the completion of each test the result of the test is indicated in the matrix on the right 

hand side of the test panel. For each test the matrix lists the number of occurrences of each 

result and the number of tries performed. 
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Creating a CTS Test Report 
You can save the test results as a report in HTML format. Select File > Save Report … A 

dialog will open where you can insert information about the DUT and remarks about the 

test. Details of the used test equipment and the software and firmware version will be added 

automatically. 

Viewing the CTS Test Report 
The report file can be viewed with any HTML browser. The report has built-in views for 

Report Summary, Test Summary, view of individual tests and view of all information.  
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APPENDIX A. PRODUCT SPECIFICATION 

DPR-120 
Input 1 x DisplayPort™ HBR2 and MST compliant Rx, ST 

Microelectronics STDP9320 controller (DP In) 

Outputs 1 x DP 1.2 multi stream Tx (DP Out) 
1 x DP 1.1 compliant preview monitor (Monitor Out) 
S/PDIF coaxial audio monitor 
TRS headset audio monitor 

Resolutions  4096 x 2160 input & pass through 
2560 x 1600 preview 

Audio Up to 2 LPCM channels at 192 kHz, 24-bits or multi-channel 
compressed (AC3, DTS, etc) compliant with IEC60958 / 
IEC61937 

Control USB 2.0 interface 

Software Debug and Test Controller GUI 
Test Automation Shell (option) 
DP RefSink CTS LL Extensions (option) 

Power supply AC/DC Power supply  
(100 to 240 Vac 50/60 Hz input, +5 Vdc output) 

Mechanical Size 230 x 168 x 56 mm 

Weight 0.9 kg w/o power supply 

 

All specifications are subject to change without notice. 
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APPENDIX B: TEST AUTOMATION SHELL 

Test Automation Shell (TA Shell) is a license enabled optional feature for DPR-120. It 

enables the user to create simple automated test routines. All functions that are in the DTC 

GUI can also be accessed through the TA Shell. 

Please find below a quick list of TA Shell commands. For full description of each 

command, please refer to Shell_User_Manual.pdf included in the DPR-120 Release 

Package. 

Help <topic> [...] 

Exit 

Open <Device ID> 

List 

Close 

CLS 

Run <DOS_Command> 

 

License add <key> 

License list 

License remove <key-index> 

License save 

License load 

 

DPIN HPD <Operation> 

DPIN Linkconfig show 

DPIN Linkconfig <Lane_count> <Speed> <MST> <TPS3> 

DPIN DPCD Read <Address> [Length] 

DPIN DPCD Write <Address> <Data1> [Data2] 

DPIN DPCD Save <Target-file> <Address> [Length] 

DPIN DPCD Load <Source-file> 

DPIN Status 

DPIN Streams 

 

SINK EDID Load <Source-file> 

SINK EDID Save <Target-file> 
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DPMON Select <Stream_Index> 

DPMON Read <Data_ID> 

DPMON Log Start <Data_ID> <Target_File> 

DPMON Log Stop <Data_ID> 

 

CTS List 

CTS Config load <config_file> 

CTS Config save <config_file> 

CTS Config show [conf_entry] 

CTS Config Link <Max-lanes> <Max-rate> <HPD_Timeout> 

CTS Config flags <'+'|'-'> <Flag1> [Flag2] […] 

CTS Config ta_flags <'+'|'-'> <Flag1> [Flag2] […] 

CTS Config ready_event <Event> 

CTS Config timestamp <BitRate> <Lanes> <ResolutionID> 

CTS Config most_packed <ResID1> <ResID2> <ResID4> 

CTS Config colorimetry <'+'|'-'> <CL_ID1> [CL_ID2] […] 

CTS Run <Test_Index> 

 

Proceed 

Pass 

Fail 

Abort 

 

CTS Report DUT_Model <String> 

CTS Report DUT_Revision <String> 

CTS Report DUT_FW <String> 

CTS Report DUT_Serial <String> 

CTS Report DUT_Driver <String> 

CTS Report Tester <String> 

CTS Report Remarks <String> 

CTS Report show 

CTS Report save <Target_File> 
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